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Chapter 1

Introducing the Program
The Stock Options Risk Analyzer allows you to plan actions related to your employer
stock options in a way that takes risk tolerance into consideration.

System Requirements
Minimum: 200Mhz, 32MB of memory
Preferable: 450 MHz processor or faster
Operating system: Windows 95 or later.
Notes: The calculator has a built-in optimization routine whose speed depends on the
speed of the processor. For instance, optimization of a seven-stock-options example takes
eight seconds on a 200 MHz processor, but only two seconds with an 800 MHz
processor.

Installation
Before you install the program, be sure that you’re running a Windows 95 or later
operating system. Stock Options Risk Analyzer does not run on Windows 3.1 or earlier
operating systems.
Installing the Program
Insert the disk into the disk drive.
On the Windows Taskbar, click the Start button.
On the Start menu, click Run. The Run dialog box appears. In the Open box,
A:\setup.EXE should appear. If it doesn’t, type A:\setup.EXE.
Click OK.
The setup program begins. Follow the instructions in the setup program.
Uninstalling the Program
On the Windows Taskbar, click the Start button.
Point to Settings and click Control Panel. The Control Panel window appears.
Click Add/Remove Programs. The Add/Remove Program Properties dialog box
appears.
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Use the scrollbar to find the Stock Options Risk Analyzer. When you find it, click the
program title. Notice that the Add/Remove button is now functional.
Click the Add/Remove button.
The uninstall program begins. Follow the instruction in the uninstall program.

What Do You See on the Screen?
When you run the program, the Stock Options Risk Analyzer window opens.
Title Bar
The title bar is the blue bar that appears in the top of the window. It contains the
following information:
Program title
Program version number
File name (if the file has been saved)
Toolbar
The toolbar contains graphics as commands. You can click these graphics instead of
using the related Menu bar commands to Open, Save, Print, and get Help.

Hint Line
At the bottom of the active window is the Hint Line. The Hint Line displays short
commands to help you with data entry. As you move the pointer across buttons, boxes,
and other areas of the window, the Hint Line displays different commands.

Shortcut Keys
Use the Function Keys as shortcuts for frequently used program commands.
F1

Access the Help system.

F2

Save data to a file.

F3

Open files.

F6

Access the Print window.

F9

Recalculate data.
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Chapter 2

Working with Files
Frequently Used Procedures
Refer to this chapter to view instructions for procedures that you’ll use frequently when
working with files.

Create a New File
On the File menu, click New. The program clears all previous data entry and resets the
program’s default values.
Open an Existing File
On the File menu, click Open. The Open Inputs dialog box appears.
In the File name box, enter the name of the file to open. Be sure you have selected the
proper drive and folder of your file.
Reopen File
On the File menu, click Reopen. The program lists the files you worked on most
recently. Select the file you want to work with from the list.
Save a File
On the File menu, click Save. The Save Inputs File dialog box appears.
In the File name box, type a name for the file. The program automatically adds an .sra
extension to the file name.
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Select the drive and folder in which to save the file.
Save an Existing File (Save As)
On the File menu, click Save As. The Save Inputs File dialog box appears.
In the File name box, enter a name for the new file. The program automatically adds an
.sra extension to the file name.
Select the drive and folder in which you want to save the file.
Set Up a Printer
On the File menu, click Printer Setup.
Report Options
On the File menu, click Report Options. Set the fonts for each report element by clicking
on it. Click on the options you wish to include.
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Print
On the File menu, click Print.
The print dialog box will appear.

On the right, check the boxes of the reports you wish to print. The Standard Report is the
default setting and includes all of the reports listed. If you wish to customize and choose
from the list, uncheck the Standard Report box and then check the boxes of those reports
you do wish to print.
The left side of the window shows printing options. To send the report to the printer for a
printed copy, click Send To Printer. To see what the printed report will look like, click
the Print Preview button.
If you want to select one of the individual reports—Valuation, for example—to work on
in Word, you can use the Print to a Text File button. The text file that you generate you
can open from within a word processing program. You can also print to a WK1 file and
work on the data from within Excel.
Click the Report Options button to set the fonts, margins, page numbers, headings, and
other settings.
Click the Printer Setup button to select the printer to which your document will print, the
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properties, the paper, and the orientation.
At the bottom of this window, the currently selected window is displayed.
Location of Data Files
On the File menu, click Location of Data Files. The Location of Data Files dialog box
appears.
Enter a directory name to which files should be saved. You can save individual files to
other locations.

Exiting the Program
On the File menu, click Exit. The program closes.
Note: Be sure to save the open file before clicking the Exit command.
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Chapter 3

Stock Options Theory
Stock Options Basics
This section provides a brief overview of stock options. It is discussed at a very basic
level, and the terminology is explained using simple examples. For more formal
definitions, please refer to the Glossary.
Stock options are a form of compensation provided by corporations. A stock option is the
right to buy a fixed number of shares at a specific price for a specific period of time.
Suppose that on 1/1/2001 (the grant date) an employee was granted a stock option that
has a grant price (also called strike price) of $10, with a vesting date of 1/1/2003, and
an expiration date 10 years from the grant date. This means the employee has the right to
exercise the options, purchasing the stock at $10 any time after the vesting date of
1/1/2003, and until the expiration date. Suppose the stock price has risen to $25 five
years after the grant date. If the employee then purchases the stock, he will have
exercised the option. He will need to pay $10 to purchase the option. In this example the
exercise price is $25. The $15 difference between the market price and the grant price
is called the spread or the bargain element. The market price is sometimes referred to as
the Fair Market Value, or FMV.
After the exercise, the employee owns the stock. He may then sell the stock. Suppose he
sells the stock two years later, when the market price is $30. The sale price is $30, and
his gain will be $30 minus $10 = $ 20.
The tax consequences on the transactions depend on the type of option that is granted.
We will first describe these two classes of options and then discuss the tax consequences.
The two most common types of options are the NSOs (non-qualified stock options) and
ISOs (incentive stock options). An ISO is an option that meets certain IRS code
regulations, including the following: you must be an employee to receive such an option;
the expiration date may not exceed 10 years; and no more than $100,000 in such options
can vest in any one year. An ISO will give you special tax treatment, if you hold onto the
stock for at least one year after the exercise and at least two years after the grant. An
NQSO is an option that does not need to meet these regulations: it can be given to nonemployees; it can have expiration dates greater than 10 years; any number of options can
vest in a given year; and you can sell the option at any time after the exercise.
Now let’s discuss the tax consequences for transactions with ISOs and NSOs, using the
example from above. When the option is granted, there are no tax consequences. You do
not owe any money to anyone when you receive the grant. When you exercise the grant,
you own the stock. In the example, the grant price was $10, the FMV upon exercise was
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$25, and the bargain element was the difference: $15. This $15 is a gain, so taxes will be
due on the gain, at some time.
With an NQSO, the $15 bargain element is considered compensation income and is to be
included in your current year Federal Income Tax calculations, even though you have not
sold the option share as yet. You will also need to pay State Taxes, Medicare Taxes and
Social Security taxes on this gain. In the example, the stock was sold two years later at
$30. The unrealized gain on the sale date is $30 minus $25 = $5. This is a capital gain,
and since the holding period is greater than 1 year and one day, the applicable tax is 20%
* $5 = $1. Note that the gain when the option is exercised is taxed at the ordinary income
tax rates, and the gain from the exercise to the sale is taxed at capital gains rates. This
suggests that there may be an advantage to exercising earlier to move the gains from
ordinary income tax rates to the lower capital gains rate. But we are getting ahead of
ourselves; there are many other considerations in deciding when to exercise, such as risks
and the volatility of the stock.
The taxation rules are different for ISOs. Let’s consider the same example—grant price
$10, price at exercise $25, price at sale two years later $30. As with the NQSO, nothing is
owed to anyone when you are granted this option. Upon exercise, you do not have to
report the $15 gain as ordinary income. When you do sell the ISO, the total realized gain
is $30 minus $10 = $20. The tax on this $20 gain is at long-term capital gains rates =
20% * $20 = $4. So all of the gain, from grant price to sell price, is taxed at capital gains
rates. Note that if you sell the option within one year of the exercise or two years from
grant, its special tax treatment changes, and it is treated more like an NSO. This sale is
called a disqualifying disposition. Note that there are times that you may want to make
such a disqualifying disposition. For instance, if the stock is volatile and you anticipate a
drop in the price of the stock, you may be better off selling the stock immediately and
taking the cash, rather than waiting one year to get the capital gains tax advantage. Again,
we are getting ahead of ourselves and discussing risk aspects. That is the main thrust of
this calculator: to show you how to take risk into consideration in making these complex
tradeoff decisions. More on this later…
There is one other tax consequence in transactions related to ISOs. While the bargain
element of $15 (exercise price minus grant price = $15) is not reportable as ordinary
income, it does need to be reported as a preference item for calculations of Alternative
Minimum Taxes (AMT). The AMT tax is an alternate tax that needs to be computed in
parallel with the Regular Income Tax. Details of AMT calculations are described in the
glossary. A simple explanation is provided here. If the AMT tax calculates to be less than
the Regular Tax, you will not owe additional taxes. If the AMT tax computes to be
greater than the Regular Tax, you will need to pay the additional Regular tax plus the
excess of the AMT over the Regular Tax. For example, if the Regular Tax in a given year
is $30,000 and the AMT tax computes to $25,000, you do not owe any additional tax due
to AMT. However, if the AMT tax computes to $32,000 then you will owe an additional
tax of $32,000 minus $30,000 = $2,000. The total tax for this year then is $32,000. Since
you have paid an extra $2,000, the IRS also lets you carry this excess as a credit, called
the AMT credit, into the next year. If next year your Regular Tax is $28,000 and the
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AMT tax computes to $20,000, you will be allowed to reduce your Regular Tax by the
credit from the previous year, i.e., the tax you owe in this following year will be $28,000
minus $2,000 = $26,000. So, in this example at least, you fully recover the additional
AMT tax one year later. If however, the AMT tax in the following year computed to
$27,500, you would only be allowed to recover $500 of the AMT credit ($28,000 minus
$27,500) in this second year; the remaining available credit of $1,500 is carried forward
to the third year. This calculator accounts for multi-year AMT carry forward credits.

Stock Options Risk-Based Analyses
This section describes the basics of risk-based analyses as applied to stock options. We
will first discuss traditional fixed-rate analysis then cover risk-based analyses.
In traditional analyses the rates of return are assumed to have a fixed value. For example,
if one uses an 8% rate of return for a portfolio, the portfolio will grow at a fixed 8% per
year. Generally, the rate of return chosen is the mean rate of return, obtained from
historical data. If the starting value of the portfolio is $100,000, the projected mean value
in 10 years will be $100,000*(1+. 08)^10 = $185,093. However, because the rate of
return fluctuates, the projected asset in year 10 will have a range of values, depending on
the volatility of the portfolio. The $185,093 is the mean value, which is just one of the
possible values in the range of possible outcomes. Specifically, this range has a
lognormal distribution, and there is a 40% probability that the assets value exceed
$185,093, with a corresponding 60% probability that the asset value will be less than
$185,093. Stated differently, there is only a 40% chance that the portfolio will have
$185,093 (or more). This traditional analysis is also referred to as a mean-only analysis,
a linear analysis, or a fixed-point analysis, which is characteristic of deterministic
analyses that do not take volatility into consideration.
Most clients will either be seeking a higher confidence level for the stated result or would
like to see the result versus confidence level. To provide this more significant and
realistic information, one needs to do a probabilistic analysis, which takes the volatility
of the portfolio into consideration. Probabilistic analyses are also called stochastic
analyses.
A typical probabilistic analysis may state the result in the following way: the portfolio
value in year 10 ranges from a low of $200,000 to a high of $400,000; specifically, there
is an 80% chance the assets will exceed $200,000 and a 20% chance the assets will
exceed $400,000. A conversational way of communicating this is “The low-to-high for
assets in year 10 ranges from $200,000 to $400,000.”
A deterministic analysis leads to limited and often misleading results. For instance, in
retirement planning modeling, a deterministic analysis may suggest that a client with
$1,000,000 at retirement can withdraw ~$68,000 per year through a 30-year retirement.
However, since this is a mean-only analysis, there is a 60% chance they will run out of
16
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money. This mean-only can lead clients to a false sense of security and can be
misleading. A statistical analysis will suggest that with a $45,000 withdrawal per year,
there is an 85% confidence that the client will not run out of money. This is a much more
relevant and realistic way of addressing a client’s retirement spending affordability.
In stock options analyses, with typical rates of returns for the company stock and for the
diversified portfolio, the deterministic analysis will generally suggest that the clients
would maximize their assets if they were to exercise their options on the last day before
expiry and hold the stock from then on. This is the exercise last and hold strategy.
However, depending on the volatility of the stock, there is a significant risk that the client
will end with far fewer assets than suggested by the mean-only analysis. The exercise and
hold recommended “best strategy” will generally not be the best if the client is risk
averse.
It would be much more responsible to offer the client a risk-reward profile. Such an
analysis would look something like this:

1

2

With a high-risk strategy (such as exercise last and hold: strategy 2 in the figure), the
range of outcomes has a large spread between the high outcomes and the low outcomes.
A more conservative (such as exercise now and sell: strategy 1 in the figure) will lead to
a higher bottom value, but also a lower top value. Such stochastic analyses can show the
risk-reward tradeoffs. Such a presentation allows the client and advisor together to plan a
strategy commensurate with the client’s risk tolerance and risk-affordability.
This is a simplified example showing the concept of stochastic analysis. Extensions of
this concept are described in the following. One could show this result for a range of risk
levels. Additionally, if one had the time and patience, theoretically one could also do a
number of what-if analyses assuming different exercise and sell dates to search for the
best combination of exercise/sell years for each of the grants, so as to maximize the assets
with a given confidence level. This last iterative step is a manual approach that is
analogous to an optimization search. With such analyses, a conservative client could be
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shown the diversification plan that would maximize his assets with an 80% confidence
level. At the other extreme, a client who can afford to lose much of his stock options
assets may be willing to accept a diversification strategy that has some chance of
generating large assets, even though the minimum outcome can be very low. He could be
shown the risk-reward tradeoff for a plan optimized at 50% - 70%. This may have the
“aggressive” client rethink his true risk tolerance and lead to a more conservative
strategy.
The calculations suggested in the above have all been built into the calculator. The Stock
Options Risk Analyzer can be used to show the risk-reward tradeoffs for different
strategies. Additionally, it has an optimizer built into it, which will automatically search
through a large number of possible exercise/sell strategies and seek out the one optimum
strategy that will maximize the assets, for a given risk level.
Such probabilistic analyses provide the advisor and client with a broader framework with
possible outcomes to facilitate a decision consistent with their risk tolerance and riskaffordability.
In contrast, a deterministic mean-only analysis provides a single point in the spectrum of
outcomes, and one that tends to be aggressive and may lead to decisions that are very
risky with the result that the client loses much more of his assets than he could tolerate.
This is what happened to many clients in the down market of 2000. This and other
probabilistic calculators are a step towards avoiding such pitfalls in planning, by
providing a measure of the risk that is associated with certain aggressive actions. Even
though the analyses are based on historical volatility data, and the past history is not a
projection for the future, the acknowledgement of volatility in financial planning is a wise
step in risk-reward based planning. Assuming a volatility of zero, as in mean-only
analyses, provides a simplified analysis, but one that is not recommended.
The best analogy I have read in warning against mean-only analyses is a quotation from
the Nobel Laureate Milton Friedman:
“Never try to walk across a river just because it has an average depth of four feet.”

Beyond Monte Carlo™ Technology Used in Stock Options Risk Analyzer
In this section, we will describe the Beyond Monte Carlo™ (BMC) technology that is
used for the probabilistic optimizations used in the Stock Options Risk Analyzer. The
name is descriptive of a method that is analogous to the classical Monte Carlo
simulations but takes significantly less computational time.
Consider an example case in which the client has five grants of Company X, with
different grant prices expiring in different years. Assume that the last expiration date is
seven years from today. The diversification model assumes that the grants can be
exercised in any year before their expiry dates, and that they can be sold in any year on or
18
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after the exercise. After selling the stock, it is assumed that the proceeds are invested in
an alternate portfolio. The total asset value is computed at some time in the future,
referred to as the end of the analysis date. All grants can be sold in any year on or before
the end of the analysis date.
If the end of analysis date is 15 years from now, all assets are assumed to be sold in the
15th year. The asset value is the net value after paying for all exercise costs and taxes. The
time line for a one grant is shown here:

The Total Net After Taxes (TNAT) is computed for all assets at the end of the analysis.
These assets will include proceeds from all of the grants and the portfolio. The
probability distribution of this TNAT is computed using a statistical analysis algorithm,
which is similar to the Monte Carlo technique, but is significantly faster. This patentpending algorithm technique is called the Beyond Monte Carlo™ technique (BMC for
short) and is described in the section on Stochastic Analysis Technology.
As we had said earlier, the calculator is designed to find the optimum diversification
strategy that will maximize the TNAT at a given risk level. This step requires an
optimization search of many combinations of exercise and sell years for each of the
grants. The optimization algorithm is described in the section Optimization Algorithm.
The calculator uses the statistical rates of return for the stock and the portfolio to compute
the probability distribution of the TNAT. The rates of return are characterized by their
mean and the standard deviation. These are inputs to be provided by the advisor. As an
aid, the mean and standard deviation for some categories of stocks and portfolio are
included in the input window. Alternately, the advisor may want to download the
statistical data from standard sources on the Internet. Note that the directional
diversification strategy is relatively insensitive to the exact volatility. Thus it is generally
adequate to use the average volatility for classes of stocks. The additional effort required
in gathering the mean and volatility for the specific stock may not be necessary to
establish the relative risk-reward tradeoffs.
Given these inputs together with the input data on the stock options and tax data, the
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calculator computes the probability distribution of the total net assets after taxes at
different risk levels. The advisor will need to assess the risk level at which the assets need
to be optimized. This assessment of risk level will depend on how much risk the client
can afford to take (risk affordability) and on his subjective risk tolerance. The assessment
of risk levels is a necessary planning step before using this calculator. The factors that are
generally taken into consideration in such an assessment are the client’s other holdings,
when the client will need cash from these options, his objective overall asset allocation,
and his subjective risk tolerance. For example, a client who needs a certain amount of
cash with a high level of confidence would likely need to use a conservative strategy, and
the advisor would select a diversification strategy that optimizes his assets with a high
level of confidence (at probability levels of 80% to 90%). At the other end of the
spectrum, a client who has a high-risk tolerance, has significant other non-stock assets,
and can afford to take the risk of the assets being depleted may want to select a
diversification strategy that is optimized with a 50% to 60% probability. The calculator
will show the risk reward tradeoffs at different levels of aggressiveness, to help arrive at
the strategy the client is most comfortable with.
The calculator uses the following probabilities to correspond to risk levels:
Conservative: 90% confidence
Moderate:

80% confidence

Aggressive:

70% confidence

These are subjective assessments of probabilities that correspond to loosely defined risk
tolerance terms. The advisor can alter the probability levels for the analyses in the
Advisor Information window of the calculator.

Stochastic Analysis Technology
This section provides some background on the technology used for computing the
statistics of net after taxes.
A popular way of computing statistics is using Monte Carlo simulations. In this approach
the analysis is repeated several thousand times with random variables conforming to the
statistics of the input rates of return. The probability distribution can then be derived by
analyzing the corresponding several thousand results for TNAT. The accuracy of the
resultant statistics will depend on the number of such analyses. Typically 2,000 to 5,000
iterations are required to get acceptably repeatable results. The accuracy obtained is
inversely proportional to the square root of the number of iterations used in the Monte
Carlo analysis.
The algorithm for deriving the optimum diversification strategy for multiple grants can
require many such “Monte Carlo” analyses. For example, a seven-grant analysis requires
20
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close to 100 such Monte Carlo analyses, each of which requires ~3,000 iterations. Even
with today’s super fast computers, such a probabilistic optimization takes a few minutes.
This would be impractical for an interactive session with clients and would be quite
prohibitive for a web-based calculator.
An alternate technology is used in this calculator, one that is approximately 100 times
faster than the Monte Carlo technique, with an accuracy level that typically matches a
10,000-iteration Monte Carlo analysis. The technology is the Beyond Monte Carlo™
algorithm and has a patent pending. It is based on a computation of first and second order
sensitivities of the objective function to the input random variables. These sensitivities
are coupled with the statistics of the input random variables to compute the statistics of
the objective function. For a 15-year analysis, the number of sensitivity analyses required
is 30. The results are exactly repeatable and have been shown to have an accuracy that
matches Monte Carlo analyses with 10,000 iterations. If one assumes that 3,000 to 5,000
iterations are sufficient for a Monte Carlo analysis, the relative speed improvement
provided by this technique is a factor of 100 to 166. Note that in separate studies the
author has observed that both the 10,000 MC and the BMC provide results that are within
~2% of a reference run (which is established by averaging five 100,000 MC runs). If one
just uses accuracy as the comparison metric, the speed up provided is 10,000 / 30 = 333.
The 100 search diversification optimum example with seven grants took less than two
seconds on an 800 MHz processor. Equivalently, this would take two to three minutes
with the Monte Carlo technique. This is a breakthrough technology, which can be used
for a wide range of financial problems. The author first used the algorithm in the 1970s at
Bell Laboratories, as an alternate to Monte Carlo, to assess the statistical analyses of
active amplifier circuits. It has also been used to solve similar problems associated with
retirement planning.
The following provides an example comparing the relative accuracy of the Monte Carlo
versus the BMC technique. Monte Carlo analyses were done using Decisioneering’s
Crystal Ball. In this example the BMC analysis matched the 10,000 Monte Carlo analysis
to within ~ 2%. Similar results have been established for other problems with stock
options as well as in general retirement planning models.
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Example comparing Monte Carlo with BMC

Type of Option
Exercise Price
Expiry date
Sell Years after exercise
Net Assets in year 5
Stock Mean
Stock Std Dev
Portfolio mean
Portfolio std dev
# of shares

MC Iterations
2,000
5,000
10,000
BMC
BMC vs. 10,000 MC

22

ISO
20
1/1/2005
1
5
10%
15%
9%
8%
1000

Comparison of Monte Carlo vs. BMC
Standard Deviation
Exercise in Year 1
Exercise in Year 5
Monte Carlo 1 Monte Carlo 2 Monte Carlo 1 Monte Carlo 2
$25,302
$26,319
$33,075
$33,906
$25,260
$25,812
$33,012
$33,772
$25,488
$25,799
$33,295
$33,738
$26,097
2.4%

$26,097
1.2%

$33,942
1.9%

$33,942
0.6%
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Optimization Algorithm
The algorithm used to search for the optimum diversification strategy is described in this
section.
The first step in the algorithm is to find a good starting point for the search. This is done
by exploring TNAT at the probability specified for four extreme cases: exercise all
options now and sell, exercise all options now and hold, exercise all options in the last
year and hold, exercise all options in the last year and sell. The best of these four
alternates is the starting point. From there on the algorithm seeks for exercise and sell
years to improve on the TNAT. Note that each analysis involves computing taxes for
each of the years from now to the end of the analysis, using the tax rates specified by the
2001 tax legislation and multi-year AMT carry forward credits. An iterative step is
required to converge on the annual tax rate.
The next step is to search for an optimum. This is done by perturbing the exercise and sell
year for each grant, and continuing to do so if the TNAT improves. If the TNAT does not
improve, revert back to the last best scenario. Other techniques are used to seek out the
global optimum. For the examples checked to date, the convergence takes no more than
two cycles of optimization searching. As a check, one can revert to the manual user-enter
to verify that other years of exercise and sell do not improve on the TNAT.
For more details on the search algorithm and for information on licensing the BMC
technology, please refer to www.beyondmontecarlo.com or contact the author at
info@beyondmontecarlo.com.
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Chapter 4

Using the Calculator

Overview of the Calculator
The Stock Options Risk Analyzer is a tool designed to address planning issues. The
planning is shown as a three-step process.
Step 1: Inputs. Establish client’s goals and collect the input data.
Step 2: Valuation. Determine the value of the client’s current stock option
holdings. Both the current market value of the holdings as well as the time
value is shown. The Black-Scholes model is used to assess the time value of
the options.
Step 3: Planning. Decide how to address the client’s immediate needs. These
immediate needs can be stated as a certain amount of cash that the client
requires, or a certain number of shares the client requires. The calculator will
determine how many grants to exercise and will also show which of the grants
to exercise (based on a Black-Scholes ranking). All taxes are taken into
consideration: Federal, State, Social Security, Medicare and AMT, and the tax
regulations used conform to the 2001 tax legislation.
Develop a diversification plan for the remaining options, based on the
client’s risk tolerance. Demonstrate both aggressive and conservative plans
with simple-to-understand bar charts. The diversification plan addresses the
plan for the remaining vested options, after meeting the immediate needs.
A probabilistic calculation is done to show how many grants and which of the grants
to exercise and/or sell this year and in the following year. The calculator will also
show the optimum years in which to exercise and sell the remaining grants. This
optimum diversification strategy will maximize the client’s total net assets from all
their grants at some future point in time (e.g., 15 years from now). The probabilistic
analysis is based on the assumed rate of return of the stock and the rate of return of
the diversified portfolio. These rates of return are characterized as having a mean
value and a volatility component that is described by the standard. The concept of
using probabilities and risk in such analyses is explained in the following paragraph
with a simplified example.
The resulting net assets corresponding to a diversification strategy are shown as
having a range of values. For instance, the result may say, “with this moderate risk
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diversification strategy, the client’s net assets in year 15 will range from $500,000 to
$2,000,000. Specifically, there is a 75% probability of net assets exceeding $500,000,
and a 10% probability of exceeding $2,000,000.” A more aggressive strategy will
lead to a wider range of possible outcomes (example: $200,000 to $4,000,000). In this
illustrative example, the moderate strategy may call for an immediate exercise of 25%
of the client’s grants, while the aggressive diversification may correspond to waiting
till the last day before expiration to exercise the options, and then holding the stock
until the 15th year.
The reader should note that this example was chosen for illustrative purposes, to
explain the concepts behind the analyses done in the Stock Options Risk Analyzer.
This figure illustrates the three-step process.

Step 1: Enter Inputs

Step 2: Show Valuation of Options

Address Immediate
Needs
Step 3. Exercise / Sell Now

Step 3. Develop Diversification Plan

Step 3. Cash Needed Now

Create illustrative
Graphs
Prepare Reports
Save Profile
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Inputs and Outputs
This section summarizes the inputs used and outputs provided by the calculator.
Inputs:
Client goals
Risk levels for analyses
NSOs and ISOs data
Federal tax data, AMT tax and credits data, state tax rate
Growth rate and volatility of stock and the alternate portfolio
Opportunity costs
Dividend rates
Payment alternatives: cash, exchange shares
Outputs:
Valuation
Valuation of Options
Intrinsic value and time value (based on Black-Scholes)
Immediate Needs
Which grants to exercise for cash needs (based on Black-Scholes)
Which grants to exercise / sell if percentages are specified
Exercise Sell All
Cashless Exercise
Maximum ISOs exercisable without incurring AMT
Diversification Strategies
When and how much to diversify (versus risk level)
Optimum time to exercise / diversify (versus risk level)
Net Assets vs. probabilities
Net Assets vs. time
Risk vs. reward for selected strategies
Standard pre-selected strategies
Cash flow
Tax calculation details (based on 2001 tax legislation)
Cashless exercise
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Step 1: Inputs
Establish client’s goals and gather the inputs. The windows for this step are shown in the
following figures.
Client Data
The first tab is labeled Client Data. Enter the client’s name, account number, address,
phone and fax numbers, and email address. Enter the advisor’s information in the pop-up
labeled “Advisor Information.” The advisor can change the probabilities associated with
the risk categories in the screen. The confidence level associated with each risk tolerance
can be entered in this screen. This is the confidence level that the client will have more
than the assets calculated. Correspondingly, there will be a 10% risk that the client will
have less than the assets calculated
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Step 1: Goals
The immediate needs can be entered either as Cash Needed Now or in terms of the
number of options that the client wants to exercise and sell. Immediate needs are defined
to be needs other than diversification (which is considered in the next planning step).
If Cash Needed Now is enabled, the Exercise / Sell strategies tab will be disabled.
Similarly, if the Exercise / Sell percentages are specified, then the Cash Needed tab is
disabled.
The next step in the planning is to plan the diversification strategy for the options that
remain after addressing the immediate needs.
The last entry on this screen is the client’s risk tolerance. The calculator uses the
following probabilities for the categories shown: Conservative 90%, Moderate 80%, and
Aggressive 70%. These probabilities can be changed manually in the relevant diversify
screen, and globally in the Advisor Information window.
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Step 1: Tax
The income tax section lets you enter data required for computing ordinary taxes in the
current and future years, using tax regulations based on the 2001 tax legislation.
The calculation assumes that the 2001 tax legislation will not sunset.
A fixed tax rate is used for state taxes.
In the AMT section (see section on AMT taxes in the Glossary for details):
Preference items—items that were not taxed under the Federal tax system but are taxed
under the AMT system—should not include the bargain element for exercised ISOs.
Examples of other preference items that are included in AMT tax calculations are mining
and development costs, intangible drilling costs, research and development costs,
accelerated deprecation on certain depreciable properties, magazine and pre-publication
and expenses.
Itemized deductions should include only the allowed deductions for AMT calculations.
The carry-forward credit refers to AMT taxes that were paid in previous years that
generated an AMT credit.
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Step 1: Growth
Stock Price refers to the market price of the stock. It does not include the time value.
This entry can be changed in this or later windows to do what-if analyses with different
stock prices.

Stock Section:

The rate of return for the stock is entered under this heading. This is used in developing
the diversification strategy. You can select Custom Defined and enter the mean and
standard deviation for the stock based on your own inputs. Alternately, the calculator lets
you select a category for the stock and provides average values for these categories. The
averages are generally adequate to reach decisions on diversification strategies.
Also, if please note that that the mean, standard deviations, and names of the
classifications have changed in the new version of Stock Options Risk Analyzer.
Therefore, if you open an .SRA file that you created in an older version of the software,
the record will assign the classification as being of the fifth type (designated as the
custom classification) and retain the old classification name. A Rename button will
appear, and you can then rename it your custom setting or adopt the new settings and
new correlating name for the classification in the new software.
The standard deviation entered here is also used in the computation of the time value of
the option using the Black-Scholes formula.
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The dividend rate refers to dividends associated with the stock. This is included in the
calculations of Net After Taxes.
Portfolio Section:

You can select Custom Defined to enter the mean and standard deviation of the portfolio
that will be used for diversified funds. Alternately, you can select from the standard
categories provided. The standard categories provided assume the portfolio is well
diversified among a number of asset classes. The standard deviations are based on
historical data and the means presume a risk premium [for the stock market, represented
by the S&P 500, over 5 year Treasury bonds] of 5%. This data is used in the
Diversification strategy calculations
Also, if please note that that the mean, standard deviations, and names of the
portfolio classifications have changed in the new version of Stock Options Risk
Analyzer.
Therefore, if you open an .SRA file that you created in an older version of the software,
the record will assign the portfolio classification as being of the seventh type
(designated as the custom classification) and retain the old classification name. A
Rename button will appear, and you can then rename it your custom setting or adopt the
new settings and new correlating name for the portfolio classification in the new
software.
The risk-free rate of return corresponds to the rate of return of short-term T-bills. It is
used in the calculation of time value of options based on the Black-Scholes formula.
Opportunity Cost is the rate of return that could have been obtained on assets used for
paying exercise costs and taxes. Opportunity costs are included in the analysis to provide
a fair comparison of alternate exercise / sell strategies. The default value shown is the
cost of borrowing funds.
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Step 1: Stock Options
Data for the stock options is entered on this window.

No. of options is the total number that was granted.
Expiry date is the date on which the options expire.
The grant price is the price at which the options can be exercised.
Options exercised refers to any options that have already been exercised at the time of
this analysis. The number of remaining options is the difference between the Number of
Options granted and the number exercised. This is the number that will be used in the
analysis. Of the options exercised, if some have been sold, the remainder is shares that
are held. These held shares can be used as Exchange Shares for paying Exercise Costs
(see the glossary for a definition of exchange shares). Note that the held shares are no
longer options, and as such, do not enter into any of the calculations.
The Add grant button opens up a row to allow entry of a new grant. Up to 39 grants may
be entered.
The Delete grant button will delete the grant that is highlighted.
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Other stock holdings are shown for information purposes. This is a reminder to the
advisor in considering overall asset allocation and other planning steps. This data is
expected to be used in future releases of this calculator.
The vesting schedule for each grant is entered in the associated window.

Vesting data can be entered as a number or as a percentage of the total granted. The
number column must add up to the number of grants for each option. The percentages
must add up to 100%. The calculator automatically calculates the percentages from the
numbers and vice versa.
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Step 2: Valuation
This window shows the value of the current options holdings.
Both the intrinsic value and the time-plus-intrinsic-value are calculated (Black-Scholes
value).

The radio buttons allow you to select options that are displayed in one of three categories:
All available options include vested and non-vested options but exclude options already
exercised.
Vested options include options that have been vested as of the date field on this screen.
This date field and the FMV field can be changed to see future valuations at different
prices. Non-vested options refer to all options that are not vested as yet.
Note these valuations consider exercise costs but do not consider tax liabilities. The net
valuation in future years is calculated on the Diversify window.
Note also that non-vested options cannot be exercised until they do vest at a later date. As
such, non-vested options do not enter into the calculations for meeting immediate needs.
Further, they are not included in the analysis of diversification strategies.
Note the small computer button on the right side of the window, opposite the radio
buttons. Click the computer button to print a grid of the valuation data you have entered.
34

Stock Options Risk Analyzer

Step 3: Planning
Cash Now
This window is used for showing which grants to exercise / sell to meet current cash
needs.
If the client does not have immediate cash needs, enter $0 for Cash Needed and skip this
window.
It is possible to use this window to calculate all of the client’s needs, including cash for
diversification. In that case, the Diversify window would not be used.

Cash Needed is the same value entered on the Inputs section. The maximum cash that
can be taken assuming that all options are exercised and sold is shown as Max.
Available. The Cash Needed value is limited by the Max. Available.
The FMV and Date can be changed for what if analyses. Any new values entered will be
reflected in the other windows.
The order of grant exercise/sell is based on the ratio of the intrinsic value to the BlackScholes value. The higher ratio grants are sold first. This order can be changed in the
Exercise Algorithm menu. You can elect to sell NSOs first or ISOs first. “All Grants”
does not distinguish between ISOs and NSOs in the ordering sort.
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The Override Sell / Exercise button allows you to change the grants exercised and sold
manually.
If the AMT tax is $0 or less, and if there are remaining ISOs that have not been exercised,
the Zero AMT field is enabled. Clicking on this button induces a calculation that tells you
how many additional ISOs could be exercised without incurring an AMT tax liability. If
additional ISO options are exercised, the net cash available is reduced.
Held shares are the difference between options exercised and options sold.
Options Unsold is the available options minus the sold options. These are the options that
will be included in the Diversify Strategy.
Note that the results shown in this window assume no diversification. This is the planning
first step. Diversification is the second planning step.
Tax Details
The Tax Details button shows the details of the ordinary tax and AMT tax calculations
for the current year.

The terms used in this screen are explained in the following:
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Ord. Taxable before options:
Ordinary income minus adjustments, exemptions and deductions ($100,000 -$5000$2900*2 - $20,000 = $69,200.)
Ord tax before options
Federal tax on the ordinary income ($69,200). This does not include AMT tax. ($12,780).

AMT tax due before options
If the AMT tax due exceeds federal (ordinary) tax, the excess is the AMT tax due. (AMT
tentative tax is $8,320; since this is less than ord tax, AMT tax is $0.)

Total tax due before options
The sum of federal tax and AMT tax minus AMT credit usable and available. ($12,780 $4,460: the maximum credit that can be subtracted is the excess of ord tax over AMT
tentative tax $12,780-$8,320 = $4,460. The max available credit was $5,000.)

Ord. Taxable from options
For NQSOs (and ISOs that have been disqualified) the amount subject to ordinary tax is
the current market value minus the grant price ($45,000).

Ord. Taxable with options
Ord. Taxable before options + Ord. Taxable from options ($69,200+$45,000 =
$114,200).

Ord. Tax with options
Considering options income, the sum of federal tax and AMT tax minus AMT credit
available ($25,304).

Ord. Marginal tax from options
Total tax with options minus total tax before considering options ($25,304-$12,780 =
$12,524).
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Ord. Marginal tax rate
Marginal tax with options divided by taxable amount from options (12,524/45,000=
27.83%).

AMT taxable from options
For ISOs the difference between exercise price and the grant price. (Here, $0.)

AMT tax tentative before options
The calculated AMT tax considering ordinary income and options income. This is
considered tentative, since it may or may not result in additional tax. (AMT tax on
$114,200 considering deductions is $20,020.)

AMT tax
This is the AMT tax that will be due. It is the excess of AMT tax tentative over ordinary
tax due. (AMT tax tentative is less than ordinary tax, so AMT tax is $0.)

Available Credit
This is credit from previous years that is accumulated if the AMT tax was paid in the
previous years ($5,000.)

Total tax with options
This is the Ordinary tax plus any Amt tax minus available AMT credit. The usable AMT
credit is limited to the excess of the AMT tentative over ordinary tax ($25,304$5,000=$20,534.)

Carry forward credit
This is the AMT credit that is carried forward to future years. It includes any available
credit not used in the current year.
Marginal tax with options
Total tax with options minus total tax without options ($20,304-$8,320=$11,984).
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Cash Flow Details
The Cash Flow details exercise costs, taxes, cash generated, and the value of the
remaining options. In this pop up you can elect to pay for exercise costs with exchange
shares. Clicking on OK will initiate a recalculation.

State Tax:
Note that state tax is reduced by the federal tax deduction for state taxes
Medicare tax
Note that Medicare taxes apply only to NQSOs
Total Tax
Marginal tax plus state tax plus Medicare tax
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Exercise / Sell Now
This window is used if immediate goals are shown in terms of a percentage of options to
be exercised / sold.
If the client does not have any immediate needs, enter 0% for Percent to Exer and 0%
for Percent to Sell, and skip the Exercise/Sell window.
If the client does not wish to consider diversification actions at this time, the
diversification window can be skipped.

This window may be used to calculate all of the client’s needs. In that case, the Diversify
tab would not be used.
The FMV and the Date can be changed for what-if analyses. These changes will be
reflected in the other windows.
The percentage of options to exercise and sell is carried in from the Goals section in the
Input windows. The “exercise/sell all” strategy can be calculated by entering 100% for
both these inputs.
The order of grants to exercise/sell is based on the ratio of the intrinsic value to the
Black-Scholes value. The higher ratio grants are sold first. This order can be changed in
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the Exercise Algorithm menu. You can elect to sell NSOs first or ISOs first. “All Types”
does not distinguish between ISOs and NSOs in the ordering sort.
The Cashless button will be enabled if there is Balance cash needed. This button initiates
an iterative calculation, showing the number of additional shares that need to be sold to
make this a cashless transaction (this is also called a sell-to-cover transaction). The
percentage to sell will be updated, and the corresponding sold shares will be shown on
the table.
If the AMT tax is $0 or less, and if there are remaining ISOs that have not been exercised,
the Zero AMT field is enabled. Clicking on this check box induces a calculation that tells
you how many additional ISOs could be exercised without incurring an AMT tax
liability. The percentage to exercise and the table values are updated.
The Override Sell/Exercise button allows you to change the grants exercised and sold
manually.
Held shares are the difference between options exercised and options sold.
Options Unsold is the available options minus the sold options. These are the options that
will be included in the Diversify Strategy.

The Tax Details button shows the details of the ordinary tax and AMT tax calculations
for the current year. The Cash Flow details exercise costs, taxes, cash generated, and the
value of the remaining options. In this pop up you can elect to pay for exercise costs with
exchange shares. Clicking OK initiates a recalculation. Descriptions of these windows are
shown in the Cash Now section of the manual.
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Diversify
This window is used to develop a diversification strategy.
If the client does not wish to consider diversification actions at this time, this window can
be skipped.

The number of options brought into this window is the Unsold Options shown in the last
column of the Cash Now or the Exercise/Sell window.
The FMV and the Date can be changed for what-if analyses. These changes will be
reflected in the other screens.
The evaluation year is the year in which the net assets are calculated. All assets, including
options, stocks and the portfolio, are liquidated in the indicated evaluation year. The
evaluation year can range from zero to 15. The zero selection shows the net cash
generated if all options are exercised and sold today. A graph of net assets versus time is
shown in the Graphs screen
The asset values in the last column are shown at the selected probability labeled “Net
After Tax Confidence.” If the confidence level selected is 80%, there will be an 80%
chance that the net assets will exceed the value shown. Correspondingly, there will be a
20% probability that net assets will be less than the value shown.
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When the strategy selected is “Optimum,” you will need to specify the confidence level
for the optimum search. This is entered as a probability in the text box labeled “Calculate
Optimum for.” For example, if you enter 90%, the calculator searches for and finds the
strategy that maximizes assets for a 90% confidence level. The label under this cell
indicates the level of risk corresponding to the selected probability. These subjective risk
levels are taken from the Advisor Window.
The default values for the probabilities for different risk levels are based on the Risk level
indicated in the Input Advisor window. We have chosen the following default probability
values for the indicated risk levels: 90%, Moderate 80%, and Aggressive 70%.
The rates of returns (for both mean and standard deviation) can be changed by clicking
on the Edit Growth Rates button.

A mean only analysis can be shown by forcing the standard deviations to 0%.
Alternately, results very close to the mean only analysis will be generated if the Net After
Tax Confidence is reduced to 40%.
Strategies Analyzed:
The strategy to analyze is selected in the Strategy menu. One of the four boundary
strategies or the Optimum strategy can be selected. The four limit strategies are exercise
all options now and sell now; exercise all options now and hold to the end of analysis
year; exercise all options on the last day of expiration and sell then; exercise all options
on the last day and hold till the end of analysis. ISOs are sold one year after the exercise
in these boundary cases. The results for these boundary cases are shown for different
probabilities in the Graphs screens.
If the Optimum Strategy is elected, the optimization algorithm is initiated. The calculator
searches through a large number of combinations for exercise and sell for all the grants
and selects the combination that maximizes the Net Assets in the end of analysis year, for
the confidence level selected. The optimum net assets for different levels of risk levels
are shown in the Graphs screens.
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The calculations on the exercise and sell strategies are displayed in two sections.
Columns 5, 6 and 7 show the number of options to exercise now, sell now and sell one
year. This is the immediate action view. The actions for the balance of the options
(displayed in Column 8) are shown as the year in which the grant is to be exercised and
the year for the sale. If the balance options after the first / second year is zero, a blank for
the Year of Exercise and Year of Sale is shown.
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The Optimum vs. Risk button initiates a calculation of the net asset at three confidence
levels and presents a compact view of the immediate actions that would correspond to
conservative, moderate, or aggressive strategies. The results in this pop-up show the
number of options to exercise now, number to sell now, and the number to sell next year.

The Cashless button forces the optimization algorithm to disallow any solutions that
require out-of-pocket cash for exercise and sell in the current year. This Cashless
optimization will generally lead to a solution that will be different from an optimization
that does not stipulate this condition.
If the AMT tax is $0 or less, and if there are remaining ISOs that have not been exercised,
the Zero AMT field can be checked. Clicking on this button will induce a calculation
that tells you how many additional ISOs could be exercised without incurring an AMT
tax liability. The percentage to exercise and the table values will be updated.
The Tax Details button shows the details of the ordinary tax and AMT tax calculations
for the current year.
The Cash Flow details exercise costs, taxes, cash generated, and the value of the
remaining options. In this pop-up, you can elect to pay for exercise costs with exchange
shares. Clicking OK will initiate a recalculation of the optimum, or boundary strategy
selected, assuming that these exchange shares are going to be used.
Descriptions of the Cash Flow and Tax Detail windows appear in the Cash Now section
of the manual.
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Graphs
This section explains the graphs used to illustrate the diversification strategies.

Diversify Strategies
The Diversify Strategies graph illustrates the net value of the assets in the evaluation
year. The assets for each of these strategies is shown at two confidence levels, the values
for which can be changes in the Display Range text boxes. You can elect to display at just
one probability by un-checking one of the display probabilities.
The optimum pair of bars corresponds to a strategy that has been optimized at the
confidence level shown in the Optimize at text box.
The current price of the stock and the growth assumptions (mean and standard deviation)
of the stock and portfolio can be changed for what-if analyses.
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Assets vs. Time
The Assets vs. Time graph is shown here. It illustrates the net assets after paying all taxes
and exercise costs versus time. In each year displayed, it is assumed that all assets are
liquidated. The graph is displayed for the Optimum strategy, optimized at the confidence
level shown in the “Optimum at” text box. Alternately, the graph can be displayed for the
User defined scenario selected in the Diversify Screen. The assets are shown for a range
of confidence levels: the low and high values for this range can be changed in the Display
Range text boxes. You can uncheck one of the display probabilities. Either Optimum or
the Current Diversify Strategy can be shown, one at a time.
The price and growth rates can be changed for what-if analyses.
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Risk Level
The third graph shown here, Risk Level, displays the asset ranges for conservative,
moderate, and aggressive strategies. The optimization probabilities for each of these risk
levels can be changed in the Advisor Information window. The assets are displayed at a
range of confidence levels that can be changed in the Display Range text boxes. You can
uncheck one of the Display Range probabilities.
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Probability Distribution
The fourth graph displays the asset values at different risk levels. Such a graph is referred
to as the Probability Distribution Function (PDF). It shows the net assets in the last year
of analysis (typically year 15) at a range of confidence levels. This range can extend from
5% to 95% and can be changed in the text boxes labeled Display Range. Each bar set
(identified by a color) describes the PDF for a strategy optimized at the indicated
probability level. The graph can also display the PDF for the User-Defined strategy
selected in the Diversify screen. You can view just one strategy or both strategies.
The price and growth rates can be changed for what-if analyses.

Stock Options Risk Analyzer

49

Chapter 5
Glossary

Adjusted gross income
Total income minus certain adjustments, including alimony, moving expenses, student
loan interest, contributions to retirement plans, contributions to medical savings plans,
one half of self-employment tax, penalties on early withdrawals from savings. This is the
income before applying exemptions and deductions.
AMT (Alternative Minimum Tax)
A second system of income taxation, parallel to the ordinary tax system, that applies to
certain taxpayers who have taken advantage tax preference items. The bargain element
(difference between the exercise price and the grant price) of an ISO that has been
exercised is a preference item. Thus, while no ordinary tax is due on the exercise of an
ISO, the bargain element needs to be included in AMT tax calculations. This may incur
an AMT tax liability.
•

Preference items
Examples of other preference items that are included in AMT tax
calculations are mining and development costs, intangible drilling costs,
research and development costs, accelerated deprecation on certain
depreciable properties, magazine and pre-publication and expenses.

•

Itemized deductions
Certain itemized deductions are not allowed in the calculations of AMT
tax. The itemized deduction items allowed are all of the items on Schedule
A: casualty and wagering losses, charitable contributions, medical
expenses (with a 10% floor), qualified interest expense, deduction for
estate taxes for recipients income with respect to decedents. State tax and
theft are not allowed. A home acquisition mortgage is one of the very few
deductions that are allowed for the alternative minimum tax. Interest from
municipal bonds is not deductible and must be included in AMT.
Investment interest (interest incurred to buy investments that generate
taxable interest income) is deductible for alternative minimum tax up to
the amount of your investment income. Therefore, you cannot deduct
investment interest that exceeds the investment income you received.
Qualified interest (housing and investment) is an allowed deduction.
Estate tax on income in respect to a decedent is also allowed.
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•

•

AMT exemptions
The AMT exemption depends on the filing status of the individual. The
following are the exemptions allowed in 2001 (per the 2001 tax
legislation). For married filing jointly, the exemption is $49,000 with a
phase out that starts at $150,000; for Married filing separately, the
exemption is $24,500 with a phase out that starts at $75,000; for Single
and head of household, the exemption is $37,500 with a phase out that
starts at $112,500.
AMT tax calculations
Individuals are required to compute both their ordinary tax and AMT tax
liabilities. If the AMT tax liability is greater than the ordinary tax, the
excess difference is the AMT tax that will be owed.

The basic principles for AMT tax calculations are outlined here. You are advised to
consult with your tax advisor for the specific guidance on AMT tax calculations.
1. Start with the taxable income for ordinary tax calculations.
2. Add back the larger of standard deduction or itemized deductions that are not
allowable for AMT purposes. Add all preference items, including the bargain
element for exercised ISOs.
3. Add personal and dependency exemptions
4. Subtract the allowable AMT exemption. This step results in the AMTI, the
Alternative Minimum Tax Income.
5. Multiply the AMTI by the AMT tax rate (26% on the first $175,000 and 28%
thereafter). This results in the tentative alternative minimum tax.
6. If the AMT tentative tax is greater than the ordinary tax, the difference is the
additional AMT tax that will be added to the ordinary tax. Note that the additional
amount that may have paid is carried forward to the next year as an AMT credit.
If, in the next year, the ordinary tax is greater than the AMT tentative tax, this
credit can be used to reduce the ordinary tax (but only up to the difference
between the ordinary tax and the AMT tentative tax). If the AMT tentative tax is
lower than the ordinary tax, no AMT tax will be owed.
AMT credit
A credit that becomes available when alternative minimum tax exceeds ordinary federal
tax. The excess tax is a credit that is carried forward to the next year.
AMTI
Alternative Minimum Tax Income
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Bargain element
The difference between the price at which an option is exercised (which is the market
value on the day of the exercise) and the grant price. So if the grant price is $20, and you
exercise when the market price is $35, the bargain element is $15.
Basis
In connection with a stock that you own, the basis is the amount you paid for the stock at
the time of the purchase. If you sell the stock, you will pay taxes on the excess of the
stock price over the basis.
When you exercise an NQSO, the basis is the sum of the amount you paid for the
exercise and the bargain element you reported on your taxes. At the time you exercise an
ISO, the basis is just the exercise price that you have paid.
In connection with stock owned in a qualified plan (such as a 401(k) plan); the basis in
the stock is the amount that was paid to purchase the stock. If such stock is distributed out
of the plan, you will need to pay taxes on the basis at the time of distribution. The gain is
called the net unrealized appreciation (NUA), and you pay taxes on this NUA only at the
time of sale of the stock. No tax is immediately due if the stock is rolled over into an
IRA.
Black-Scholes
Developed by Nobel Prize winners, this is an equation that quantifies the time value of an
option. The parameters included in this valuation are the grant price (strike price) of the
option, the current market price of the option, time to expiry, volatility of the stock, and
the risk free rate of return. Note that the Black-Scholes value is the same as the intrinsic
market value on the day of expiration, and that the Black-Scholes value increases as the
time to expiration increases.
Cashless exercise
A method of exercising (and then selling) your options in which you do not need to come
up with money to pay for the exercise of your options. Usually, the company makes
arrangements with a brokerage firm for such a transaction. The brokerage firm loans the
money required to purchase the options you want to exercise; the brokerage firm then
sells some or all of the stock immediately, and part of the proceeds is used to pay the very
short-term loan. Another part may be used to cover any withholding taxes that apply, and
also any brokerage commissions and other fees that may be applicable.
Disqualifying disposition
If an ISO is sold within one year after the exercise, or within two years after the grant,
you have incurred a disqualifying disposition, which requires you to treat this option as
an NQSO (Non Qualified Stock Option). Thus the bargain element must be included for
ordinary tax purposes.
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The Economic Growth and Tax Relief Reconciliation Act of 2001
The Economic Growth and Tax Relief Reconciliation Act of 2001 included significant
changes to the federal ordinary and alternative tax rules. An additional 10% bracket has
been added. The current bracket percentages will be gradually decreased until 2006. The
AMT exemption amount has been increased. These rules have been incorporated in this
calculator. Note that current law assumes a Sunset provision that will revert all tax rules
in the year 2011 to the 2001 rules. This calculator assumes a Repeal, which means that
the tax laws in effect in 2010 will continue after 2010.
Evaluation year
This is a term specific to this calculator. It refers to the future point in time when all
assets (stocks, portfolio) will be valued. It is assumed that all assets will be liquidated on
this date, and the asset value calculated will be net after paying any remaining exercise
costs and taxes.
Exchange Shares
Some companies permit you to pay for the exercise cost of options with shares of that
stock that you already own. This relieves you from coming up with cash to pay for the
exercise costs. However, exchange shares are not used to pay for any taxes due (in this
calculator). An advantage of using exchange shares is that you will not need to report
income for the shares you used to pay for the exercise. The shares that you receive by
virtue of the exercise will have the same basis (and holding period) as the exchange
shares that were used for the exchange. This calculator indicates the maximum number of
exchange shares that can be used in the pop-up labeled Cash Flow.
Exercise
You exercise an option when you notify your company that you want to purchase the
stock. After the exercise you own the stock as a share. Before the exercise you have the
right to purchase the stock.
Exercise price
The market price of the stock on the day you exercise the option.
Exercise Sell Algorithms
1. Exercise now and sell: all options are exercised today, NSOs are exercised today,
and ISOs are exercised one year from today.
2. Exercise now and hold: all options are exercised today, and sold on the last year
chosen for the end of the analysis.
3. Exercise last and sell: all options are exercised on the expiration date, NSOs are
sold on the same day, ISOs are sold one year after the expiration date (or the last
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year of the analysis, whichever is earlier.
4. Exercise last and hold: all options are exercised on the expiration date and sold on
the last day selected for the end of the analysis.
The user can manually enter other years for exercising and selling options. The calculator
includes an optimization routine that automatically finds the best set of exercise and sell
years to maximize assets for a given risk level.
Expiration date
The day on which the option expires.
Fair market value
The price of the stock on the open market.
Grant price
The price that you will need to pay to purchase the stock from your company.
Holding Period
The holding period is the amount of time you have held the stock. If the holding period is
greater than a year and a day, and you then sell the stock, long-term capital gains rates
will apply. The holding period starts on the day you exercise the stock and ends when
you sell the stock.
For an ISO you will need to sell the stock later than one year plus a day after the exercise,
and two years and a day after the grant, in order to be eligible for long-term capital gains
treatment.
Intrinsic value
The value of the option based on the current market price minus the grant price. This
does not include the time value of the option. This is the same as the bargain element, or
the spread.
ISO basics

Incentive stock option. See the section on Stock Options Basics in this manual
Marginal tax with options
The additional tax that needs to be paid due to options activity. This is the difference
between the tax owed with no options activity (based on your regular income) and the
tax owed on the regular income plus options income.
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Mean rate of return
The mean rate of return is the average rate of return. It is generally based on historical
data.
Monte Carlo
An algorithm used to compute the statistics of a result based on using random numbers to
represent the input variables. See the section on Stochastic Analysis Technology for more
details.
NAT
Net after taxes. This is the value of assets after taking all taxes and exercise costs into
considerations. In this calculator all assets are liquidated to derive the NAT. The NAT is
equal to the gross amount from sales minus exercise costs minus all taxes minus
opportunity costs.
Net unrealized appreciation
A term used to describe the gain of stock that was held in a qualified plan (such as a
401(k) plan). The NUA is the difference between the current market price and the price at
which the stock was purchased (basis). If the stock is distributed from the plan, the tax on
the NUA is deferred until the sale of the stock.
Non-qualified options
Also referred to as non-qualified stock options. Abbreviations used are NSO or NQSO.
See the section on Stock Options Basics in this manual.
Non-vested options
Options that have been granted to you but can only be exercised at some date in the
future. The date on which it can be exercised is the vesting date.
NQSO
Also referred to as non-qualified stock options. Abbreviations used are NSO or NQSO.
See the section on Stock Options Basics in this manual.
NUA
See Net unrealized appreciation
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Opportunity cost
The cost associated with using cash funds for payment of exercise costs and taxes before
the end of the analysis date. It is subtracted from gross sales in computing the net after
taxes.
Optimization
An algorithmic technique used to search through a number of what-if scenarios to find
one that provides the maximum net after taxes. See the section on Optimization
Algorithm for more details.
Out of the money
A term used to indicate that the option grant is less than the current market price of the
stock.
Portfolio
A term used in the calculator to describe the alternate investment used after the stock is
sold.
Portfolio mean
The mean rate of return for the diversification portfolio

Portfolio standard deviation
A measure of the volatility of the diversification portfolio
Probability
The likelihood of an event occurring, expressed as a percentage. In this calculator, the
statement “net assets are $100,000 with a probability of 60%” means there is a 60%
confidence the assets will be $100,000 or more; conversely there is a 40% risk the assets
will be less than $100,000. See the section on Stochastic Analysis Technology for more
details.
Qualified plan
A retirement plan that is eligible for a rollover into a traditional IRA. Examples are a
defined benefit plan, a defined contribution plan, profit sharing plans, 401(k) plans,
403(b) plans (per the 2001 tax legislation), cash balance plan, and target benefit plan.
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Reload
If the option has a reload feature, when you exercise and pay for the exercise price with
shares that you already own, the company will not only give you the shares that you have
exercised, but will also give you additional options equal to the number of shares you
used for the exercise. The additional options will usually expire at the same time as the
options that were exercised.
Risk
A term used to describe the uncertainty of an outcome. An individual’s risk tolerance is a
measure of how accepting he would be of poor outcomes.
Risk-free rate
The rate of return associated with a risk-free investment. This is usually the rate of return
provided by a short-term treasury bill.
Section 83b
Some plans may allow you to exercise your options before they become vested. If you
chose to do so and you make an 83(b) election, the holding period for the stock received
will start on the day the stock is received. In this calculator, if an 83(b) election has been
made, the corresponding options would need to be treated as vested options.
Spread
The difference between the current market price of the option and the grant price. This is
the same as the bargain element.
Standard deviation
A term used to describe the volatility of the stock or the portfolio. The rate of return for is
described by a mean value and a standard deviation. See the section on Stochastic
Analysis Technology for more details.
Stock option
A stock option gives an individual the ability but not the obligation to purchase the stock
for a stated price over a prescribed period of time. See the section on Stock Options
Basics in this manual for more details.
Time value
The time value of an option is the value attributed to potential future growth. The Black-
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Scholes formula provides one way of quantifying the time value.
Under water
A term used to indicate that the market price of the stock is less than the grant price of the
option.
Vesting schedules
The date(s) on which you can exercise the option to buy the stock
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Chapter 6
Getting Help

If you need help, it’s easy to find. Click the question mark wherever it appears in the
program and a Help topic appears for the screen in which you are working. Also, use the
Help menu and the program’s Help system. If you still need help, Brentmark provides
technical support.

Help Menu
Use the Help menu on the Menu bar to access the Help system, learn how to use Help, or
view information about this product and other Brentmark products.

Help System
The program provides a complete Help system, so you can get help whenever you need
it. Just click the question mark that appears in the top right corner of every data entry
section. Use the Help system’s table of contents to view Help topics by category or
search the Help index for specific terms.

Technical Support
Technical Support is available by telephone, Fax, e-mail, or postal mail. If you have
questions concerning program calculations, please have a list of your exact data entry
values available when contacting us.
Telephone

Assistance by telephone is available Monday through Friday between 9:00 AM and 6:00
PM Eastern Standard Time at (407) 306-6160.
Fax

For assistance by fax, send your fax to (407) 306-6107.
E-mail

For assistance via e-mail, send your remarks to support@brentmark.com.

60

Stock Options Risk Analyzer

Postal Mail

For assistance by postal mail, write to:
Brentmark Software, Inc.
3505 Lake Lynda Drive, Suite 212
Orlando, FL 32817-8327

In your correspondence, please include the following information:
The name of the person who registered the program.
A contact phone number.
The program name and version number.
Your system configuration.
A sample printout or description of the problem.
A list of any error messages that have appeared.
Brentmark on the Web

On the toolbar, click the globe graphic to access Brentmark’s website.
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